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Preface 
 

 

Visual C# 2015, one of the components of Visual Studio 2015, is one of the most powerful, 
versatile and modern object-oriented programming languages available today. Developed by 
Microsoft, it combines all the best features available in programming languages. 

C# provides a rich repertoire of library/built-in functions that allow programmers to develop all 
kinds of applications with relative ease - be it Console, Windows/Forms, Web or Mobile 
Applications.  

This book is intended for beginners as well as those with some programming knowledge. It is 
suitable for those students who are pursuing a course in Computer Science, Software Engineering, 
Information Technology, Management Information Systems, Engineering and Mathematics. It starts 
with the basics, and gradually progresses to more advanced topics such as arrays, structures, classes,
text files and databases. So whether you are a beginner or intermediate programmer, this book will 
help you master the essentials of C# very quickly. The book is written in a simple, easy-to-read 
style and contains numerous examples to illustrate the concepts presented. It also contains exercises 
at the end of each chapter to test your grasp of the subject matter.
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Chapter 1 
 

Introducing C# 
 

 
 
Learning Outcomes: 
 
After completing this chapter, the student will be able to 
 

• Describe the Visual Studio 2015 Integrated Development Environment. 
• Differentiate between Console and Windows Applications. 
• Explain the different parts of a C# program. 
• Edit, compile and run C# programs. 

 
 
1.1 Visual C#.Net 
Microsoft’s Visual C# 2015 is one of the most popular general-purpose object-oriented programming 
languages. It’s powerful, versatile and relatively easy to use. You can use it to develop a wide range of 
applications that run on the .NET Framework. It comes with a rich repertoire of built-in functions/methods 
which programmers can use to develop Console, Windows/Forms, Web and Mobile Applications, distributed 
components, client-server applications, and more. It comes with an advanced code editor, interface designer, 
integrated debugger and other tools for easy coding and testing.

Using C# has many benefits:
 

• It is relatively easy to use.  Editing, compiling, running and debugging C# programs using the 
Integrated Development Environment (IDE) is easy. 

• It is powerful and versatile. 

• It can be used to develop Console, Widows/Forms, Web and Mobile Applications.

• It is object-oriented. Programmers have all the benefits of the object-oriented paradigm such as 
modularity, inheritance, polymorphism and software reuse.

• It is robust, meaning, it can handle all types of situations - both expected and unexpected. This helps 
us to minimize errors in programs. 

• Modules are linked dynamically (at run-time). Only modules that are needed are linked. This reduces 
program size, saves memory, and executes faster.

• It uses the Language-Integrated Query (LINQ) to provide built-in query capabilities across a variety 
of data sources.

• It provides a rich repertoire of built-in/library functions that helps programmers to simplify 
programming and speed up the software development process.
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1.2 Visual Studio.NET 

Visual Studio.NET 2015 provides an Integrated Development Environment (IDE) for creating impressive 
applications for Console, Windows/Forms and Web and Mobile Applications, and Cloud services. It 
provides rich tools and services to candle projects of any size and complexity. (It comes with Visual C#, 
Visual Basic, C++, F#, Python, HTML/JavaScript, Node.js etc.)

1.3 The .NET Framework 
The .NET Framework is Microsoft’s computing platform created to simplify application development, 
especially for the Internet. It is a general-purpose development platform for developing any kind of 
application. It provides key capabilities for building high quality applications including automatic memory 
management and support for modern programming languages. With it, you can develop any application for 
the Microsoft platform. It comes with reusable libraries for building all types of applications. It also supports 
multiple programming languages.

The .NET Framework includes the following components:

Class Libraries
The .NET Framework comes with many predefined classes organized into different categories called 
namespaces. A namespace logically/semantically groups related functions. For example, one namespace may 
provide building blocks for developing Windows Applications; another, for Web Applications. Some of 
these may be further divided into more specific namespaces. For example, Web Development namespace 
may contain a namespace for developing Web Services.

The Runtime
The .NET Framework provides Runtime components including the following: 

Common Language Specification (CLS): This component ensures that code written in different languages 
all behave in a uniform way such as when an object is instantiated or when a method is invoked with a value 
or reference parameter. This is important in the .NET environment as code written in different languages 
(e.g., C#, C++, VB, JScript) may behave differently.

Common Type System (CTS): This component defines the basic data types such as Integer, Double and 
String. It facilitates interoperability between languages that use the .NET Framework. It makes cross-
language compatibility possible. (In the .NET Framework, you can use multiple programming languages to 
develop an application.)

Common Language Runtime (CLR): This component manages the execution of all applications developed 
using the .NET library.

Figure 1.1 illustrates the cross-language operability via the Common Type System and the Common 
Language Runtime.

 

 
Figure 1.1 Cross-language operability 
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Garbage Collector (GC) is a memory manager whose job is to reclaim memory allocated to objects that are 
no longer needed such as when an object is deleted.

Just-in-Time (JIT) Compiler compiles the intermediate language (IL) to native code specific to the target 
machine and operating system. The IL code is compiled only when needed.

The compilation of a C# program from source code to intermediate code and to native machine code is 
shown in Figure 1.2.

 
Figure 1.2: Stages of compilation of a C# program 

 
 

1.4 System Requirements 

The recommended system requirements for running C# programs are:

• 1.6 GHz or faster processor
• 1.5 GB of RAM 
• 10 GB of available hard disk space
• 5400 RPM hard disk drive
• DirectX 9-capable video card that runs at 1024 x 768 or higher display resolution
• CD-ROM drive
• Windows XP/Vista/7/8

1.5 Visual Studio.NET IDE 
When you launch Microsoft Visual Studio 2015, you will see the Integrated Development Environment 
(IDE) shown in Figure 1.3.

The IDE has several parts:

Title bar with the title Start Page - Microsoft Visual Studio

Menu bar with several menu items such as File, Edit, View, Debug, Team, Tools, Test, Analyze, Windows, 
and Help. When you click on a menu item, you will see a pull-down menu giving several options. The pull-
down menus for some of the menu items are shown in Figure 1.4. Some of the options in the pull-down 
menu have Shortcut keys. For example, the Shortcut key for New File (in File menu) is Ctrl+N and the 
Shortcut key for Properties Window (in View menu) is F4. You can use the Shortcut keys from anywhere on 
the screen without selecting a menu item.

Main Window displays the introductory “Start Page” when the Visual Studio is launched. This window is 
tabbed such that you can switch between several files with ease by clicking on their filenames.

Server Explorer and Toolbox controls appear whenever they are clicked and provide various additional 
capabilities such as access to user interface building blocks for Windows and Mobile applications.
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Solution Explorer Window displays information about the current project. 

Properties Window gives you a detailed view of the contents of the current project and allows you to 
perform additional configuration of individual elements.

Start Options provide you options such as New Project, Open Project, Open from Source Control, and a list 
of recently opened projects to start or load.

Output Window displays the output when a project is compiled or executed.

The Standard Tool bar located just below the Menu bar has several icons. These icons represent some of the 
commonly used functions such as opening a new or existing file, saving the current file, navigating backward 
or forward, undo and redo previous operation. These icons represent only a subset of the functions. To use 
other functions not available on the Standard Toolbar, you must click the appropriate menu item and select 
the desired function.
 
The Minimize, Maximize and Close buttons perform the same functions as in other Windows based 
applications. Clicking the Minimize button puts the application on the Taskbar. To activate, click the icon on 
the Taskbar. Clicking the Maximize button causes the application to fill the entire screen and clicking it 
again will cause it to revert to its original size. Clicking the Close button closes the application.

Note that some of the options in the pull-down menus in Figure 1.4 are grayed out. That means they are not 
available/applicable for use in the current context. Thus it minimizes inadvertent errors.
 
 
 
 
 

 

 
 
 
 

Figure 1.3: Visual Studio 2015 IDE 
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Figure 1.4: C# Menus 

1.6 Console Application 
To create and run a C# Console application, use the following steps:

1. Start Visual Studio, on the menu bar, Select File > New > Project
 

 
 
2. Expand Installed, expand Templates, expand Visual C#, then select Console Application.
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3. In the Name box, give a name for your project, then click the OK button.

4. Once the project is initialized, you will see the below code in the Code window. We have added the 
highlightedtwo lines of code to make the program display “Hello World!”

 
using System; 
usingSystem.Collections.Generic; 
 
namespace ConsoleApplication1 
{ 
classProgram 
    { 
staticvoid Main(string[] args) 
        { 
Console.WriteLine("Hello World!"); 
Console.ReadLine(); 
        } 
    } 
} 

 

5. Select the F5 key or click  button to run the project. A Command Prompt window will appear 
with the message Hello World!like the one shown below. 

 

 
 
6. Press any key to exit from the application.
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1.7 Windows/Forms Application 

To create and run a C# Windows application to display “Hello World!” message, use the following steps:

1. Start Visual Studio, on the menu bar, Select File > New > Project
 

 

2. Expand Installed, expand Templates, expand Visual C#, then select Windows Forms Application.
 

 
 
3. In the Name box, specify a name for your project, then click the OK button.

4. Once the project is initialized, move the mouse pointer to the Toolbox bar on the left of the screen. 
Select All Windows Forms and double click on the Button, Label, and TextBox icons to add them to the 
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main form of the application. Select the Form and change the text accordingly under the Properties 
window. Do the same for Label, and Button controls. 

 

 
 
 

 
 

5. To add code for the button, double click on the button that you just added to the form.

6. You will see some lines of code. Go to the button1_Click method and add the highlighted code shown 
below.
 
privatevoid button1_Click(object sender, EventArgs e) 
{ 
  MessageBox.Show(textBox1.Text); 
} 

 

7. Select the F5 key or click button to run the project. Enter “Hello World!” inside the Textbox.
 

Rename the form here 
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8. Click on Display button and the program will output “Hello World!” in a message box as shown below.

 

 
 
 

1.8 Editing, Compiling& Running C# Programs 
Let’s illustrate these steps for compiling and executing a simple C# Console application to display a greeting 
message. 
 
1. Start Visual Studio. On the menu bar, select 

 
File > New > Project >Expand Installed>Expand  
Templates > Expand Visual C#>Console Application 
 

2. Type the highlighted code (without the line numbers) in the Code window.
 
/* This is a multi-line comment statement; the program        [1] 
asks the user to enter his/her name and displays the          [2] 
message Good day with the user’s name  */                     [3] 
 
// these are built-in namespaces    [4] 
using System;    [5] 
using System.Collections.Generic;                             [6] 
using System.Text;    [7] 
 
// this is a programmer-defined namespace    [8] 
namespace ConsoleApplication1    [9] 
{                  [10] 
 // class starts here                   [11] 
 classMyClass               [12] 
 {                 [13] 

// Main method starts here            [14] 
  staticvoidMain(string[] args)                 [15] 
  {                [16]  
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   string name;  // variable declaration                 [17] 
   Console.Write("Enter you name: ");  // a prompt       [18] 
   name = Console.ReadLine();  // input statement        [19] 
   // the line below is an output statement              [20] 
   Console.WriteLine("Good day, " + name);               [21] 
          Console.ReadLine();                                       [22] 
  }                 [23]  
   }                                                           [24] 
}                                                        [25] 

 

3. Select the F5 key or click button to run the program. A Command Prompt window will appear 
that looks like the one shown below.

 
 
 
Note that the program is compiled automatically when you run it. So you don’t have to explicitly compile the 
program.
 
 

1.9 Parts of a C# Program 

Let’s briefly explain the various parts of a C# program. 
 
Comments 
Comments are inserted into a program to make it more readable. Comments can appear anywhere in the 
program. Comments are not executable statements; the compiler simply ignores them. 

Comments can span several lines (lines 1 to 3 in the code) or a single line (line 4). A multi-line comment 
start with the characters /* and ends with the characters */.  The pair of characters (/* and */) must 
appear together (with no space) as C# treats them as a single symbol.  

A single line comment starts with two forward slashes (//). Everything on that line after the slashes is 
treated as a comment. It can appear on a single line (line 20) or after a statement (line 17).

Line spacing 
Blank lines can be inserted in a program between statements to make it more readable. For example, we have 
inserted a blank line between lines 3 and 4. Blank lines are useful for separating methods, to begin a separate 
task, or to begin and end a lengthy loop.
 
Namespace
A namespace is a collection of related classes. C# provides many namespaces to simplify programming. The 
basic namespaces that C# programs require are System, System.Collections.Generic and 
System.Text. To use them, you must prefix them with the keyword using (lines 5-7). Note that there is 
a semicolon (;) at the end of each namespace directive. The semicolon terminates the statement. This is the 
basic rule for all executable statements unless they appear in a block enclosed between a pair of curly braces 
({}).
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The above namespaces provide the basic classes that all C# programs require. For example, the System 
namespace provides the class Console for reading input data from the Keyboard and for displaying output 
on the Screen. This class contains methods such as ReadLine()(lines 19 and 22), Write()(line 18), and 
WriteLine()(line 21). 

Keywords
Keywords (also called reserved words) have special meaning in C#. So they must only be used for their 
intended purpose. You cannot use them for any other purpose. For example, in the above code, using and 
System (line 5) are keywords.

Case sensitivity
C# syntax is case-sensitive. C# treats uppercase and lowercase letters as different characters. So you must be
careful when naming namespaces, functions and variables. For example, if you had typed the word system 
instead of System in line 5, the compiler will give you an error message. Similarly, the variables name, 
Name and NAME are all different. 

Class 
C# is an object-oriented language. Every C# program must have at least one class.The above program has 
one class: MyClass (line 12). It is prefixed with the keyword class. You can give your own class name -
one that is meaningful. The body of a class is enclosed between a pair of braces ({}) (lines 13 to 24).

Main() method
A C# program must have  the Main()method (line 15). Besides this, it can also have other methods. The 
body of each method must be enclosed between a pair of curly braces ({}) (lines 16 to 23).

Program execution will always start and end at Main(). The keywords public, static and void 
before Main()have certain meanings:

public  - Specifies that Main() can be accessed from anywhere such as from another class
another class or another project.

static  - Specifies that Main() is attached to the class (MyClass in this case) and not to an 
instance of that class.

void    - Specifies that Main()does not return any value to the calling program (operating 
system in this case).

You will need the above keywords when writing the Main() method. (There are also other keywords which 
you will learn later in other chapters.)

Parameters
The curved brackets () following Main is used to specify the parameter(s) that it needs. The above program 
doesn’t require any parameters, so there are no parameters enclosed in the brackets. But the brackets are still 
required even if a method has no parameters.

Variable declaration
Line 17 declares a variable called name of type string. The string is a keyword used to declare string 
variables. A string variable consists of a set of alphanumeric characters (letters, digits and underscores). 

A variable is used to reference a memory location where you can store a data item such as the name of a 
person. A variable must begin with a letter and may be followed by one or more letters, digits and/or 
underscores (_). Special characters such as @, %, *,&,$ are not allowed in a variable. Blanks are also not 
allowed. A variable may be of any length from 1 to 255 characters. However, in practice, a variable seldom 
exceeds 25 characters. You must give meaningful names for your variables to make your program readable.
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Input statement
Input statements allow you to read data from the Console (Keyboard). In the above program, the statement 
(line 19)

name = Console.ReadLine();  

reads data from the Keyboard, then assigns it to the variable name. The ReadLine()method on the right-
hand side of the assignment operator = is part of the Console class. 

Assignment statement 
An assignment statement has a variable on the left-hand side, the assignment operator =, and an expression 
on the right-hand side. In an assignment statement, the value of the expression on the right-hand side of the 
assignment operator is evaluated and the result is stored in the variable on the left-hand side. The expression 
can be a number, a literal, a variable, an algebraic expression or a method call that returns a value. In this 
case, the method reads a line of text entered from the keyboard.

Output statement 
Output statements are used to send output to the Console (Monitor/Screen). The above program has two 
output statements (lines 18 and 21). The statement 

Console.Write("Enter you name: ");  

displays a message/prompt on the screen asking the user to enter a name. The Write method (which is part 
of the Console class) displays the message enclosed between the pair of double quotes ("). After the 
statement is executed, the cursor will appear on the same line immediately after the prompt. 

The statement (line 21) 

Console.WriteLine("Good day, " + name); 

is similar to the previous one but it will move the cursor to the next line after displaying the message Good 
day,followed by the name. The + operator acts as a concatenation (join) operator. It joins the message and 
the name. For example, if the name entered is Sellappan, the program will display

Good day, Sellappan 

Note: Don’t worry if you haven’t fully grasped the material presented in this chapter. The purpose in this 
chapter is to introduce you to the C# programming language. The sample code is intended to give you an 
idea how a C# program looks like. As you progress to the next few chapters you will be able to write simple 
C# programs.

Exercise 

1. Explore Visual Studio 2015’sIntegrated Development Environment to view some of its main features.

2. Click on each menu item on the Menu bar and explore the functions available.

3. Write a simple Console application using the steps given in the chapter.

4. Write a simple Windows/Forms application using the steps given in the chapter.

5. Explore C# debugging facilities.
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Chapter 2 
 

Object-Oriented Concepts 
 

 
Learning Outcomes: 

After completing this chapter, the student will be able to 
 

• Explain classes and objects. 
• Explain class hierarchy and inheritance. 
• State the purpose of abstract classes and interfaces. 
• Discuss the scope and access levels of class members. 
• Discuss constructors and destructors. 
• Explain polymorphism, method overloading and method overriding. 
• Discuss object interaction.

 
2.1 Classes & Objects 

As C# is an object-oriented language, you need to be familiar with object-oriented concepts before you can 
write C# programs. These concepts include classes and objects, encapsulation, class hierarchy and 
inheritance, abstract classes and interfaces, constructors and destructors, polymorphism, method overloading 
and method overriding, object interaction and message passing.

A class is a template for creating objects. All objects from the class have the same attributes (variables) and 
methods (functions). The methods manipulate the variables. For example, all objects created from the 
Employee class will have attributes like employee number, name and salary, and functions like 
calculate salary(). 

A class encapsulates (packages) both variables and methods. It is self-contained – the methods manipulate 
the data. The variables store the object’s data while the methods manipulate its data. The variables and 
methods are called class members. 

An object is an instance of a class. You can create as many instances as you want for a class. For example, 
you can create objects like Miriam, Wong, Kamala and Susan for the Employee class as shown in 
Figure 2.1. 

 

 
 

Figure 2.1: Class and its objects 
 
A class is represented using a box diagram with three partitions. The top partition shows the class name; the 
middle, its variables; the bottom, its methods. Figure 2.2 shows the class Employee with its attributes and 
operations.
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Figure 2.2: Class attributes and methods 

 
Objects have states. The state of an object is determined by the values of its variables. Changing the values 
of variables changes the state of the object. The methods in the class change the values of these variables.
 
Static & Instance Class Members 
 
Ordinary variables of type int, double, string, etc. are allocated memory at compile time. The C# 
compiler knows exactly how much memory (in bytes) these variables require. These variables are allocated 
memory on the stack maintained by the C# system. 

Object variables like Employee, Student, etc. are allocated memory at run-time. The compiler doesn’t 
know in advance how much memory these variables require. The memory requirements for these variables 
depend on the program logic. C# allocates memory dynamically for these variables when they are created 
and frees the memory when they are deleted or no longer needed. Object variables are allocated memory on 
the heap (maintained by the C# system). Knowing the difference between stack and heap variables can help 
us write more efficient code – code that executes faster and uses less memory. 

Variables in a class can be static or dynamic. The static variables are called class variables; they are 
attached to the class. Only one copy is maintained for all objects. The dynamic variables are called instance 
variables; they are attached to each instance. 

Let’s illustrate: Assume company XYZ has 1000 employees. As all employees have the same company name 
(co_name), you need to store only one copy as shown in Figure 2.3.  

 
Figure 2.3: All class instances share the static variable 

 
 

2.2 Class Hierarchy & Inheritance 

Related classes can be organized hierarchically. For example, the classes Person, Student and 
Employee can be arranged hierarchically as shown in Figure 2.4. Here, Person is called the base, super
or parent class and Student and Employee are called derived, sub or child classes. This is an example 
of a two-level hierarchy.  

Employee 
 

EmpNo 
EmpName 

Salary 
 

ModifyInfo() 
ComputeSalary() 

Class name 

Class attributes 

Class methods 
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Figure 2.4: A two-level class hierarchy 

 

Inheritance refers to a derived (sub) class inheriting the variables and methods of its base (super) class. The 
derived classes automatically inherit all the variables and methods of the base class. That means variables 
and methods declared/defined in the base class need not be declared/defined again in the derived classes. 

Let’s illustrate: Assume classes Person, Student and Employee in Figure 2.4 have the following 
variables and methods. 
 

Classes Variables Methods 
Person Name, Age, Sex Initialize(), Add(), Modify() 
Student     StudNo, Course ChangeInfo() 
Employee EmpNo, Pay ComputePay() 

 
Figure 2.5 shows the inherited members in the subclasses Student and Employee. Thus Student inherits 
the variables Name, Age and Sex and the methods Initialize(), Add() and Modify()from the base 
class Person. In addition, it also has its own variables StudNo and Course and its own method 
ChangeInfo().

 
 

Figure 2.5: Inherited members from base class 
 
A class hierarchy can have many levels. Figure 2.6 shows a three-level class hierarchy. Here, Local 
employee inherits all the members (variables and methods) of its base class Employee, as well as 
indirectly, all the members of the Person class. 
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Figure 2.6: A three-level class hierarchy 

Abstract Classes 

Abstract classes cannot be instantiated, meaning, you cannot create instances of an abstract class. Abstract 
classes are used to specify variables and methods at a higher level. The classes that inherit the abstract class 
must implement these methods using the specified variables and methods.  

Figure 2.7 illustrates abstract classes. The base class Patient declares the variable PatientId and the 
method Delete(). The derived classes OutPatient and InPatient then implement the Delete()
method using the variable PatientId. The Delete() method in InPatient and OutPatient
overrides the Delete()method in Patient. 

Figure 2.7: Abstract classes 

2.3 Accessibility of Class Members 

Accessibility refers to the scope/visibility of class members (variables or methods). Access specifiers are 
used for this purpose. Access specifiers can be private, public, internal or protected. If the scope is 
private, the members can only be accessed from within that class; if the scope is public, they can be 
accessed from any class (including classes from other projects); if it is internal, it can only be accessed 
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by any class in the current project; if it is protected, it can only be accessed by classes within the class 
hierarchy.

What this means is: If you do not want another class to access members of a class, you declare them as 
private. If you want another class (including from other projects) to access its members, you declare them 
as public. If you want other classes in the current project to access its members, you declare them as 
internal. If you only want classes in a hierarchy to access its members, you declare them as 
protected.

By default, all members of a class are private. In that case, the keyword private can be dropped 
altogether. In general, the scope of most variables would be private while the scope of most methods 
would be public.  Public members are exposed to other classes; private members are not.
 
 

2.4 Constructors & Destructors 

A constructor is a special method that is invoked automatically when an object is created. It has the same
name as the class. It is typically used for allocating memory when an object is created and/or for initializing 
variables. C# automatically provides a constructor for each class. You can also provide your own 
constructor(s). That means, a class will have one or more constructors.

A constructor can have zero or more parameters. A constructor can be overloaded, meaning, you can have 
several constructors all having the same name but different number/type of parameters.

A destructor is also a special method that is invoked automatically when an object is deleted or goes out of 
scope. It also has the same name as the class but prefixed with a tilde (~). Destructors are typically used for 
freeing memory allocated to objects and/or for performing close-up operations such as displaying summary 
reports.  
 
 

2.5 Polymorphism 
 
Polymorphism means many forms. The term applies to methods that have the same name in a class 
hierarchy but are implemented differently. A method is said to be polymorphic if it behaves differently in the 
base and the derived classes. This feature allows two or more classes in a class hierarchy to use the same 
method name, but each class implements it differently. 

For example, in Figure 2.8, the class Shape uses the Draw()method to draw a shape. The derived classes,
Rectangle, Circle and Polygon, also uses the Draw() method, but they draw different shapes 
(rectangle, circle or polygon). So we say the Draw() method in Rectangle, Circle and Polygon
overrides the Draw() method in Shape.

 
Figure 2.8: Polymorphism 
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Polymorphism comes in two flavours: 

Compile time polymorphism refers to binding overloaded methods at compile time. This process is called 
early binding. Overloaded methods have the same name but have different number and/or type of 
parameters. They behave differently depending on the number/type of parameters. (Note that method 
overloading is not the same as method overriding.)  
  
Runtime polymorphism refers to binding methods that have the same name in the base and derived classes. 
This binding occurs at run-time and the process is called late binding. The methods in the derived classes 
override the method in the base class, thus stopping the inheritance.      

2.6 Interfaces 
 
A class must expose its services (methods) if it wants other classes to access them. That is, it must publish its 
services. Interfaces are used for this purpose. The interface (class) tells what services it provides to other 
classes. For example, if an Employee object wants to know the name of its department, it can send the 
EmpNo to a Dept object which can then access the department name and pass it to the Employee object.

Interfaces declare properties, methods and events (interface members). It is the responsibility of the  
inheriting classes to implement the methods. They are used to provide a standard structure for the inheriting 
classes.

Abstract classes can be used for the same purpose, but they are used mainly when the number of members 
that need to be inherited is small. The classes that inherit the methods must implement them. 
 
 

2.7 Object Interaction 
In object-based systems, objects must interact to perform useful business functions. Objects interact by 
passing (sending) messages to one another. Passing messages is similar to calling methods and supplying 
parameters. The called object implements the method and passes the results to the calling object. Figure 2.9 
illustrates the idea of message passing.
 

 
Figure 2.9: Message passing 

 
 
2.8 Coding for Objects 
 
As C# is an object-oriented language, writing code is slightly different from writing code for procedure-
oriented languages such as C/C++. To use an object, first create it using the class template. Then to access a
variable/method, prefix it with a dot. The code below illustrates the idea. 


